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1. Overview 

Remote update capability is one of the key advantages of FPGA. It enables deployed systems 

to be updated with design patches or enhanced capability without recalling. This is a prominent 

feature to manage remote upgrades of the application configuration images in the 

configuration device for PCI Express add in card that is designed using FPGA. It helps to 

reduce time to market and extends product life.  

This reference design demonstrates remote system update functionality on Arria® 10 FPGA 

Development Kit using PCI Express as the communication protocol. The configuration image 

from the host system is received via PCI Express in the Intel® Arria 10 device and then written 

into the serial flash by Modular Scatter-Gather DMA.The reconfiguration process of remote 

update is controlled by the dedicated remote system upgrade circuitry in the Intel Arria 10 

device and manage via PCI Express. When an error occurs, the circuitry detects the error, 

reverts to a safe configuration image, and provides error status to the design. 

A smart host can use the PCI Express protocol and the application topology to update the 

entire FPGA dynamically without requiring a system power down or host reboot. With a simple 

software model for configuration, it allows quick update of design for changing application 

loads. 

 

 

Figure 1: FPGA Design Image Deployment from Development Site to System Online 

via Remote System Update 
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2. Reference Design Hardware and Software Requirements 

2.1. Hardware Requirements  

1. Intel Arria 10 GX FPGA Development Kit. 

2. Micro USB to USB Type A cable for configuring the FPGA device. 

3. A computer with a PCIe Gen3 x8 or x16 slot running Linux Operating System. CentOS 

Linux 7.4 64bit was used for this reference design testing. 

4. A Windows or Linux computer to run Quartus Prime Pro software and configure the 

Intel Arria 10 GX FPGA Development Kit. 

2.2. Software Requirements  

1. The Linux software driver installed on the Linux computer. The reference design is 

available in the Intel FPGA Design Store and the Linux software driver is included in 

the package. Besides, the Intel Quartus Prime Pro Edition Platform Archive File (.par) 

includes the recommended synthesis, fitter, and timing analysis settings for the 

parameters specified in the reference designs. 

2. Quartus Prime Pro software, version 20.4.  

 

Related Information 

Intel Arria 10 Remote System Update via PCI Express Reference Design 

Intel Quartus Prime Pro Edition Download Center 

Intel Arria 10 GX FPGA Development Kit 

 

Note: To download this reference designs, first make sure that you have access to the 

Intel Design Store by logging into Design Store. You can then click on the link 

provided above to download the design. 

 

 

 

 

 

 

 

 

https://fpgacloud.intel.com/devstore/platform/20.4.0/Pro/intel-arria-10-fpga-remote-system-update-via-pci-express/
https://www.intel.com/content/www/us/en/programmable/downloads/download-center.html
https://www.intel.com/content/www/us/en/programmable/products/boards_and_kits/dev-kits/altera/kit-a10-gx-fpga.html


 

5 
 

 

3. Working with the Reference Design 

This reference design consists of minimal design components to enable remote system update 

functionality on Arria 10 FPGA Development Kit through PCI Express interface. The same 

design will be used to create one factory image and two application images. The difference 

between these images is the on-board user LED light setting. Factory image will have four red 

LED lights lit up when loaded, while application image 1 will have one red LED light lit up and 

application image 2 will have two red LED lights lit up when loaded.  

 

 

Figure 2: Arria 10 FPGA Development Kit 

3.1. Reference Design Package 

The reference design uses the following structure:  

• top.v – The top-level module instantiates rsu_pcie. 

• rsu_pcie.v – Platform Designer top-level files. If you modify the design (rsu_pcie.qsys) 

using Platform Designer, you must regenerate the system for the changes to take effect. 

The reference design contains the following folders: 

• driver – contains the Linux driver and software application package, 

rsu_over_pcie_arria10_driver.tar.gz 

• master_image – constains known working image files for hardware testing 

• platform – contains the IP and RTL source files 

 

User LED 
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3.2. Compiling the Factory Design 

1. Download the reference design project archive from Intel FPGA Design Store. 

2. Launch Quartus Prime Pro software. 

3. Restore the project by following the instructions on the Intel FPGA Design Store 

download page with the project folder named as “factory”. 

4. On the File menu of Quartus Prime Pro software, click Open button, and select the top.v 

file in the project directory and click Open button. 

5. At the top part of the top.v file, make sure that the FACTORY definition is uncommented, 

while APPLICATION_1 and APPLICATION_2 definition is commented. 

 
6. On the File menu, click Save to save the modification of top.v file. 

7. On the Processing menu, click Start Compilation to run full compile of the design. 

 

3.3. Compiling the Application 1 Design 

1. Launch Quartus Prime Pro software. 

2. Restore the project by following the instructions on the Intel FPGA Design Store 

download page with the project folder named as “application_1”. 

3. On the File menu of Quartus Prime Pro software, click Open button, and select the top.v 

file in the project directory and click Open button. 

4. At the top part of the top.v file, make sure that the APPLICATION_1 definition is 

uncommented, while FACTORY and APPLICATION_2 definition is commented. 

 

5. On the File menu, click Save to save the modification of top.v file. 

6. On the Processing menu, click Start Compilation to run full compile of the design. 
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3.4. Compiling the Application 2 Design 

1. Launch Quartus Prime Pro software. 

2. Restore the project by following the instructions on the Intel FPGA Design Store 

download page with the project folder named as “application_2”. 

3. On the File menu of Quartus Prime Pro software, click Open button, and select the top.v 

file in the project directory and click Open button. 

4. At the top part of the top.v file, make sure that the APPLICATION_2 definition is 

uncommented, while FACTORY and APPLICATION_1 definition is commented. 

 

5. On the File menu, click Save to save the modification of top.v file. 

6. On the Processing menu, click Start Compilation to run full compile of the design. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

8 
 

3.5. Creating Raw Programming Data File for Remote System 
Update via PCIe  

Raw Programming Data file is a binary file (with the extension .rpd) containing configuration 

data for use outside the Quartus Prime software. Below are the steps to generate a Raw 

Programming Data file that contains Factory, Application 1 and Application 2 images using 

the Convert Programming Files Wizard. 

1. Launch Quartus Prime Pro software. 

2. On the File menu, click Convert Programming Files… to bring up the dialog box as 

shown in figure below. 

 

3. In the dialog box, configure it with the setting as below: 

• Programming file type: JTAG Indirect Configuration File (.jic) 

• Configuration device: EPCQL1024 

• Mode: Active Serial x4 

• File name: ru.jic 

• Check the Create Memory Map File (Generate ru.map) option  

• Check the Create config data RPD File (Generate ru_auto.rpd) option  
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4. Select the Flash Loader and click Add Device… button to bring up the dialog box as 

shown in figure. In the dialog box, select Arria 10 for Device family, 10AX115S2 for 

Device name and then click OK button. 

 

5. Select the SOF Data and click Add File… button to locate and add factory image file 

(.sof). 
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6. Select the factory image (.sof) file and click on Properties button button to bring up 

the dialog box as shown in figure. In the dialog box, check the Compression option 

and then click OK button. 

 

7. Click on Add Sof Page button to add a new Sof Page. 

8. Select the SOF Data of Page_1 and click Add File… button to locate and add 

application_1 image file (.sof). 

9. Select the application image (.sof) file and click on Properties button to bring up the 

dialog box as shown in figure. In the dialog box, check the Compression option and 

then click OK button. 

10. Repeat steps 7 to 9 above to create Sof Page 2. 

11. Select SOF Data of Page_0 and click Properties button to bring up SOF Data 

Properties dialog box. In the dialog box, configure it with the setting as below and then 

click OK button. 

• Address mode for selected pages: Start 

• Start address (32-bit hexadecimal): 0x20 
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12. Select SOF Data of Page_1 and click Properties button to bring up SOF Data Properties 

dialog box. In the dialog box, configure it with the setting as below and then click OK 

button. 

• Address mode for selected pages: Start 

• Start address (32-bit hexadecimal): 0x2000000 

13. Select SOF Data of Page_2 and click Properties button to bring up SOF Data Properties 

dialog box. In the dialog box, configure it with the setting as below and then click OK 

button. 

• Address mode for selected pages: Start 

• Start address (32-bit hexadecimal): 0x4000000 
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14. Finally, the final Convert Programming File dialog configuration should look as shown in 

figure below, click on the Generate button to generate the ru_auto.rpd file. 
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3.6. Setting Up the Hardware 

 

 

 

 

 

 

 

 

 

 

Figure 3: Hardware Setup 

 

1. Plug the Intel Arria 10 GX FPGA Development Kit card into a PCIe slot of the Linux 

machine that supports Gen3 x8 or Gen3 x16. 

2. Connect a USB cable from computer of which Quartus Prime Pro software was installed 

to the Intel Arria 10 GX FPGA Development Kit at J3 (On-Board USB-Blaster II). 

Otherwise, you can also use an external USB-Blaster II cable to connect the computer 

to the Intel Arria 10 GX FPGA Development Kit at J17 (JTAG Header). 

3. To power up Intel Arria 10 GX FPGA Development Kit via the PCIe slot, power on the 

Linux computer. Alternatively, you can power up FPGA Development Kit using the 

external power adapter that ships with the kit. 

 

3.6.1 Program the Serial Flash (EPCQL) with JTAG Indirect Configuration 
File 

JTAG Indirect Configuration file is a binary file (with the extension .jic) containing serial 

configuration device data and the serial flash loader device name. Follow the instruction in 

section 3.5 to create JIC file. It is used to program the configuration data for a into an serial 

configuration device. The factory image will be loaded by default upon power up. Below are 

the instructions to program the a serial configuration device with JIC file. 
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1. On computer installed with Quartus Prime Pro software, invoke the Intel Quartus Prime 

programmer software from the Tools menu of Quartus Prime Pro software.  

2. Click on the Hardware Setup… button to bring up bring up the Hardware Setup dialog 

box. In the dialog box, select USB-BalsterII for the hardware and click Close button.  

 

3. Click on Auto Detect button, select 10AX115S2 device and then click OK button. 
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4. Select 10AX115S2 device and then click on Change File… button to locate and specify 

the .jic programming file.  

 

5. Check the Program/Configuration option for the EPCQL device as shown in figure and 

then click on Start button to program the EPCQL device. 

 

6. Shut down the host machine and then power up again, to allow the FPGA to be 

configured with the factory image in the EPCQL device, so that the system enumeration 

could take place accordingly.  

 

Note: If SOF configuration file is used to configure the FPGA, the FPGA must be 

reconfigured whenever the Arria 10 FPGA Development Kit loses power. Hence, make sure 

that there is no power interruption during system reboot, otherwise the enumeration will fail 

and the device can not be detected. With the serial configuration device, EPCQL been 

configured with the JIC file, the factory image will be loaded automatically upon power cycle. 

 

7. Notice that four red User LEDs lit up when the factory FPGA image is loaded sucessfully.  
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3.7. Installing the Remote System Update via PCIe Design Driver 
and Running the Application Software 

1. Copy the Linux software driver package, rsu_over_pcie_arria10_driver.tar.gz from 

reference design directory, “<project_directory>/driver” into the Linux machine of which 

the Intel Arria 10 GX FPGA Development Kit was installed. 

2. Extract the Linux software driver package by running the following commands in a 

terminal window:  

• cd /<reference_design_install_directory>/<project_directory>/driver 

• tar -xzf rsu_over_pcie_arria10_driver.tar.gz 

3. In the software driver directory, run the following command to install the Linux driver for 

the hardware: 

• sudo ./install  

4. Run the following command to execute the remote system update via PCIe application: 

•  ./run  

5. The application software prints the operation steps as shown below. Refer to figure 4 

for the software flow. 

 

 

3.7.1. Writing Application Image 1 into the Serial Flash 

1. User will prompted the operation steps while running the remote system update via PCIe 

application software. To download the application image into the serial Flash or EPCQL, 

enter “y” and press the Enter key to specify the image to be downloaded into the serial 

flash device. 
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2. Enter 0x2000000 for the Start Address and 0x356cfff for the End Address. Refer to the 

ru.map file generated by the Convert Programming File wizard for the image address 

mapping. 

 

Note:  Any change in the design might result a different fpga image size and thus a different 

end address in the .map file. Please follow the addresses in your .map file. 

3. Copy the previously generated ru.rpd file into the Linux machine that running the remote 

system update via PCIe application software. 

4. When prompted in the remote system update via PCIe application software, specify the 

path to ru.rpd file and press Enter key to proceed. 

5. Once the application 1 image has been successfully downloaded into the serial flash 

device, user will be prompted “All data store in EPCQL are correct!” and option to 

reconfigure the FPGA with the newly loaded image. 
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6. Enter “y” and press Enter key to reconfigure the FPGA with the newly loaded image. 

The FPGA is then reconfigured with application 1 image and only one red LED light lit 

up on the Intel Arria 10 GX FPGA Development Kit.  

 

 

3.7.2. Writing Application Image 2 into the Serial Flash 

1. Run the remote system update via PCIe application software.  

2. Enter “y” and press the Enter key to specify the image to be downloaded into the serial 

flash or EPCQL device. 

3. Enter 0x4000000 for the Start Address and 0x556cfff for the End Address. Refer to the 

ru.map file generated by the Convert Programming File wizard for the image address 

mapping. 

4. Specify the path to ru.rpd file and press Enter key to proceed. 

5. Once the application 2 image has been successfully downloaded into the serial flash 

device, you will be prompted “All data store in EPCQL are correct!” and option to 

reconfigure the FPGA with the newly loaded image. 
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6. Enter “n” and press Enter key to exit the application.  

 

3.7.3. Trigger FPGA Reconfiguration 

1. Run the remote system update via PCIe application software. 

2. Enter “n” and press Enter key to skip the procedure to download the application image 

into serial flash device. 

3. Enter 0x4000000 for the Start Address of the reconfiguration image in the serial flash 

device and press Enter key. 

The FPGA is then reconfigured with application 2 image and two red LED lights lit up on 

the Intel Arria 10 GX FPGA Development Kit.  
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3.8 Summary 

Once the Arria 10 FPGA is loaded with the reference design and enumerated successfully, the 

Remote System Update via PCIe application software can be used to write an application 

image in Raw Programmming File format to the target section of the serial flash and trigger 

FPGA reconfiguration to with an application image in the serial flash.  

 

Start

End

Select whether or not to 
download the application image 

into Flash

Enter the start 
address of the 

reconfiguration 
image in the 

Flash

Input start and end 
address of application 

image download to Flash

Enter programming file 
directory

Select whether or not to 
reconfigure the FPGA

Program the Flash with the 
new image

Save PCIe configuration 
space register, 

reconfigure the FPGA 
and then restore the 
configuration space 

register

 
Figure 4: Remote System Update via PCIe User Application Process Flow 

 

No 
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Yes 

No 
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4. Design Description 

The reference design top level module instantiates rsu_pcie module which is constructed using 

Platform Designer. It consists of Intel® Arria 10 PCIe Gen3 x4 Hard IP, Modular Scatter-Gather 

DMA Intel FPGA IP, Generic Serial Flash Interface Intel FPGA IP, Remote Update Intel FPGA 

IP to demonstrate remote system update via PCI Express capability. 

The 50MHz input reference clock is used for IOPLL to generate 20MHz clock for Remote 

Update FPGA IP and 100MHz clock for Generic Serial Flash Interface FPGA IP. All the IP can 

be reset asynchronously during user mode via cpu_resetn push button. 

 

Figure 5: Reference Design Clock and Reset Block Diagram 
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4.1. Design Components 

Platform Designer is used to integrate various design components or FPGA IPs to serve the 

functionalities as discussed for Remote System Update via PCIe Reference Design. All the 

FPGA IP used in this design uses Avalon Memory Mapped Interface and can be hooked up 

directly in Platform Designer.  

 

Figure 6: Platform Designer View of the Remote System Update via PCIe 

Reference Design 

 

 
Figure 7: System Address Map 

 

4.1.1. Intel Arria 10 PCIe Gen3 Hard IP 

Intel Arria 10 FPGAs include a configurable, hardened protocol stack for PCI Express* that 

is compliant with PCI Express Base Specification 3.0. The Hard IP for PCI Express IP core 

using the Avalon® Memory-Mapped (Avalon-MM) interface removes some of the 

complexities associated with the PCIe* protocol. For example, it handles all of the 
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Transaction Layer Packet (TLP) encoding and decoding. Consequently, you can complete 

your design more quickly. The Avalon-MM interface is implemented as a bridge in soft logic. 

It is available in Platform Designer.   

In this design, Modular Scatter-Gather DMA IP is used as data mover to move remote 

system update configuration data between buffer in host system memory and serial flash 

through PCIe link.  

The system is running on 32-bits Avalon-MM bus which means the 32-bits Avalon-MM 

address of a received request on the TX Avalon-MM slave port would need to be translated 

to the 64-bits PCI Express address before the request packet is sent to the Transaction 

Layer. Translation setting of 1 address page with size of 4MB page size is used in this 

design. 

In the translation, the lower 21 bits LSB will be carried forward between the 2 address 

spaces while MSB of the Avalon-MM address will be replaced with the value from the 

translation table entry. Address in Avalon-MM address space is the serial flash address 

while address in PCIe address space is the host memory buffer address. Only 1 address 

page is used in this design. The value in the translation table entry is set to host memory 

buffer address. 

 

Figure 8: Avalon Memory Mapped to PCIe Address Translation 

Related Information:  
Intel® Arria® 10 and Intel® Cyclone® 10 GX Avalon® Memory Mapped (Avalon-MM) 
Interface for PCI Express* User Guide 

 

https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_a10_pcie_avmm.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_a10_pcie_avmm.pdf
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4.1.2. Modular Scatter-Gather DMA Intel FPGA IP 

In a processor subsystem, data transfers between two memory spaces can happen 

frequently. In order to offload the processor from moving data around a system, a Direct 

Memory Access (DMA) engine is introduced to perform this function instead. The Modular 

Scatter-Gather DMA (mSGDMA) is capable of performing data movement operations with 

preloaded instructions, called descriptors. Multiple descriptors with different transfer sizes, 

and source and destination addresses have the option to trigger interrupts.  

The mSGDMA core has a modular design that facilitates easy integration with the FPGA 

fabric. The core consists of a dispatcher block with optional read master and write master 

blocks. The descriptor block receives and decodes the descriptor, and dispatches 

instructions to the read master and write master blocks for further operation. The block is 

also configured to transfer additional information to the host. In this context, the read master 

block reads data through its Avalon-MM master interface, and channels it into the Avalon-

ST source interface, based on instruction given by the dispatcher block. Conversely, the 

write master block receives data from its Avalon-ST sink interface and writes it to the 

destination address via its Avalon-MM master interface. 

The mSGDMA provides three configuration structures for handling data transfers between 

the Avalon-MM to Avalon-MM, Avalon-MM to Avalon-ST, and Avalon-ST to Avalon-MM 

modes. The sub-core of the mSGDMA is instantiated automatically according to the 

structure configured for the mSGDMA use model. 

Please refer to section 30.7.1.6. Software Programming Model in Embedded Peripherals 

IP User Guide for details mSGDMA operation flow. 

 
Related Information:  
Modular Scatter-Gather DMA Core 

 

 

 

 

 

 

 

 

 

 

https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_embedded_ip.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_embedded_ip.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_embedded_ip.pdf#page=322
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_embedded_ip.pdf#page=322
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4.1.3. Generic Serial Flash Interface Intel FPGA IP 

The Generic Serial Flash Interface Intel® FPGA IP core provides access to Serial 

Peripheral Interface (SPI) flash devices. The Generic Serial Flash Interface IP is a more 

efficient alternative compared to the ASMI Parallel and ASMI Parallel II Intel FPGA IP cores. 

The Generic Serial Flash Interface Intel FPGA IP core supports Intel configuration devices 

as well as flash from different vendors. Intel recommends you to use the Generic Serial 

Flash Interface Intel FPGA IP core for new designs.  

Below are the settings used in the design: 

Addressing mode: 4-bytes addressing 

Chip select: First device 

Baud rate: 50MHz 

Transfer mode: Standard SPI mode 

 

Please refer to section 1.5. Using Generic Serial Flash Interface IP in Generic Serial Flash 

Interface Intel FPGA IP Core User Guide for GSFI operation flow. 

 

Related Information:  
Generic Serial Flash Interface Intel FPGA IP Core User Guide 

 

4.1.4. Remote Update Intel FPGA IP 

The Remote Update Intel® FPGA IP core implements a device reconfiguration using 

dedicated remote system upgrade circuitry available in supported devices. Remote system 

upgrade helps you deliver feature enhancements and bug fixes without recalling your 

product, reduces time-to-market, and extends product life. The Remote Update Intel FPGA 

IP core commands the configuration circuitry to start a reconfiguration cycle.  

The dedicated circuitry performs error detection during and after the configuration process. 

When the dedicated circuitry detects errors, the circuitry facilitates system recovery by 

reverting back to a safe, default factory configuration image and then provides error status 

information. 

Please refer to section 1.2.1.1.1. Switching from Factory to Application Image or from Initial 

Application Image to Other Application Image in Remote Update Intel® FPGA IP User 

Guide for Remote Update IP operation flow. 

 

Related Information:  
Remote Update Intel® FPGA IP User Guide 

 

 

https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug-gen-sfi.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug-gen-sfi.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug-gen-sfi.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_altremote.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_altremote.pdf
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/ug_altremote.pdf
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5. User Application and Loadable Device Driver 

User application provides an user interface to the user and interact with driver in accessing 

PCIe BAR space register to performed configuration on IP integrated in the design such as 

mSGDMA, Generic Serial Flash Interface and Remote Update FPGA IP. It is capable to read 

programming file locally and write the programming file into the serial flash on PCIe Card as 

well as reading back the programming file content stored in the serial flash for content 

verification. Loadble device driver is using read or write functions of file_operations to offer 

PCIe read or write interface to the application. 

In order to achieve a better performance and eficiency, this design is using mSGDMA as data 

mover in transferring the large programming file from system RAM into the serial flash, EPCQL 

and transferring the programming data from serial flash to system RAM for verification. 

6. Useful APIs 

API Return Value Descriptions 

write32 (ssize_t 
dev_id, int bar_id, 
unsigned int dev_addr, 
unsigned int val) 

void This API is used to perform 32 bits write from PCIe RXM BAR Avalon-MM 
Master interface to Avalon-MM Slave interface. 
 
Example: 
write32(dev_id, 0, ADDR_GSFI_CSR+(0x1<<2), 0x1) 
This operation performs 32-bits write from PCIe RXM BAR 0 to GSFI SPI 
Clock Baud-rate Register (0x1) in 32-bits system with value of 0x1. 
 

read32 (ssize_t dev_id, 
int bar_id, unsigned 
int dev_addr) 

unsigned int This API is used to perform 32 bits read from PCIe RXM BAR Avalon-MM 
Master interface to Avalon-MM Slave interface. 
 
Example: 
unsigned int r_value=read32(dev_id, 0, ADDR_GSFI_CSR+(0xc<<2)) 
This operation performs 32-bits read using PCIe RXM BAR 0 from GSFI 
Flash Command Read Data 0 Register(0xc) in 32-bits system. The return 
value is in unsigned int data type 

 

dev_id – rsu_over_pcie device. 

bar_id – PCIe RXM BAR number, BAR 0 is used in this design. 

dev_addr – address to perform write/read. 

val – value to write. 

 

 

 

 



 

27 
 

7. Document Revision History 
List the revision history for the application note. 

Date Version Changes 

Mar 2021 2021.3.26 Initial Release 

 


